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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in June 2025

Sector Indices vs HSI / HSCEI CES120 vs China Theme Indices

Index Name
HS Mainland
+ 0,
FTSE ASD ncex - 3%
MSCI China A 50 Index F +1.8%
% Change

Equity Index Futures Access Codes

Vendor HS Mainland Banks CES 120 HSI HSCEI
Bloomberg BMWA CESA HIA HCA
Refinitiv 0#HMBI: O#HCHH: O0#HSI: 0#HCEL:
WIND MBIF CHHF HSIF HHIF
ET Net MBI CHH HSI HHI

Data Source: Bloomberg
As at 30 June 2025

Information for reference only
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Equity Index Futures & Options
Hang Seng Index (HSI) Futures & Options

HSI Products

(2025 vs 2024)

HSI Futures 132,643 (-5%)

Mini-HSI Futures 104,523 (+8%)

HSI Options 16,193 (-18%)

Mini-HSI Options 13,673 (-22%)

HSI Futures

_2Q0
o 2,781 (-38%)

HSI Volatility 0()
Index Futures

HSI Dividend
Point Index
Futures

22 (-60%)

Data Source: HKEX
* Ol compared to previous year-end
Information for reference only

As at 30 June 2025
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- HSI Futures (YoY)

Av erage Daily Volume Open Interest

(No. of Contracts) (No. of Contracts)
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127,745 (+7%) 240,000 -| === Open Interest (R-Axis)
- 150,000
200,000 - :
160,000 ’\/\’
- 100,000
10,328 (-26%) 120,000 1
80,000 - - 50,000
40,000 -
0 - 0
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27,634 (-44%) 150,000 - i I 150,000
.
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0
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HSI Options (YoY)

Open Interest
(No. of Contracts)
400,0

Av erage Daily Volume
(No. of Contracts)
60,000 -

ADV (L-Axis)
Opgn Interest (R-Axis)
45,000 - - 300,000
30,000 H - 200,000
15,000 - - 100,000
0 0

HSI Options (MoM)
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Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level

HSI & Top 5 Constituents

ey Bt I.nclludes the I.arges.t and most ('000) 50
liquid stocks listed in Hong Kong 26 - hs S| - 50 : HSI Index Tencent
Index Level 24,072.28 (As at 30 Jun 2025) HSBC ——BABA
Xiaomi — Meijtu
o - . 24 - - 42
Index Volatility (30-Day Historical) | 27.8 110 -
Index Avg. Day High-Low Range 252.08 (Jun 2025) 29 | L 34
HSCH Correlation (2025) 0.993 90 -
20 - 26
Hang Seng Index Futures 18 . . 18 70
Apr25  May-25  Jun-25 Apr-25 May-25 Jun-25
Contract Multiplier HK$50
Notional Value (1 Contract) HK$1.20Mn (As at 30 Jun 2025) Distribution of HSI Index Options Ol in Month-end
Call Put
H £
Transaction Cost 350
s 35.0 5]
Stam p Duty NA <) o
<) ~— 28.0
. 3 220 3
Trading Fee HK$10 / contract o T
T 210 ® 21.0
SFC Levy HK$0.54 / contract 2 =
& 14.0 0 14.0
2 5
Commission Rate Negotiable Py o
T 70 £ 70
Margin as of 27 Jun 2025 HK$122,500
0.0 | . . ) 0.0 | . .
0 1 2 3 0 1 2

Open Interest ("000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference only

As at 30 June 2025
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Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Futures (YoY HSCEI Options (Yo
HSCEI Products (YoY) p (YoY)
ADV
(2025 Vs 2024) Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)

240,000 - == ADV (L-Axis) - 700,000 120,000 - ADV (L-Axis) - 2,800,000
e Ope n Interest (R-Axis) Open Interest (R-Axis)
1 L 600,000 ] L 2,400,000
HSCEI Futures 161,050 (-14%) 242,885 (9%) 200000 [ co0 000 100,000 - 00,000
160,000 - ' 80,000 - A0
- 400,000 - 1,600,000
120,000 - 60,000 -
- 300,000 - 1,200,000
gll::'ll HSCEI 10,702 (+5%) 3,148 (-30%) 80,000 - - 200,000 40,000 - . 800,000
utures 40,000 - - 100,000 20,000 - - 400,000
0 - ) (piEEEEEEEEEEENME N
S 0’<\ 2 @ P I 4 Q’<\ 2 @ P 9
. N N
HSCEI Options 17,549 (-43%) 222,047 (-19%) vy Y Y vy v e e vy
HSCEI Futures (MoM) HSCEI Options (MoM)
Mini HSCEI Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
i 2,905 (28%) 16,110 (+12%) | ADV (L)
275,000 -  mmmm—m ADV (L-Axis) ~ [ 600,000 50,000 Open Intorest (R-Axis) [ 600:000
Open Interest (R-Axis)
220,000 - | 40,000 -
- 400,000 L
kil 3] A 38315 (7%)  618.293 (1%) 165,000 |\ | 30,000 - 400,000
Options v l l ,
110,000 - 1 -
: - 200,000 20,000 - - 200,000
HSCEI Dividend 55,000 - 10.000 -
Point Index 382 (-70%) 33,014 (+26%) '
Futures 0 0 0 0
333858883285 3358388858535
2024 2025 2024 2025

Data Source: HKEX
* Ol compared to previous year-end
Information for reference only

As at 30 June 2025
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Equity Index Futures & Options
HSCEI Futures & Options

HSCEI HSI vs HSCEI HSCEI & Top 5 Constituents

i he |
Index Description Comprlse.st e largest and
most liquid H shares 109 4 140 -
e HS| em——HSCEI
Index Level 8,678.30 (As at 30 Jun 2025) 107
Index Volatility (30-Day Historical) | 30.3 120 1
105 -
Index Avg. Day High-Low Range 101.69 (Jun 2025) 100
103 -
Correlation with HSI, CES120 (2025)| 0.993,0.975
i 80 -
Correlation with CSI1300, FTSEAS0 | ) 0.0 o o 101
(2025) R
99 T T T T 60
2-Jun  9-Jun 16-Jun 23-Jun 30-Jun Apr-25 May-25 Jun-25
HSCEI Futures
Contract Multiplier HK$50 Distribution of HSCEI Index Options Ol in Month-end
Notional Value (1 Contract) HK$0.43Mn (As at 30 Jun 2025) Call Put
15.0 150
o
] 5 130 st13.0
Transaction Cost* =4 ~
=110 8o
Stamp Duty N/A .8 o
& 90 £90
0] =
Trading Fee HK$3.5 / contract ;;; 7.0 ‘Q 7.0
(]
T
SFC Levy HK$0.54 / contract 3 50 £50
£
Commission Rate Negotiable s 30 | T T )
0 2 4 6 8 10 12 14 0 4 8 12
Margin as of 27 Jun 2025 HK$47,650 Open Interest ('000) Open Interest ('000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference only

As at 30 June 2025

X



Weekly HSI & HSCEI Options Performance

Weekly HSI Options

Contract Multiplier

Liquidity Providers

HK$50

ABN, BNP, Citadel, Eclipse, IMC, Optiver,
Susquehanna, Yue Kun

Transaction Cost*

Stamp Duty
Trading Fee

SFC Levy
Commission Rate

N/A

HK$10 / contract
HK$0.54 / contract
Negotiable

Weekly HSCEI Options

Contract Multiplier

Liquidity Providers

HK$50

ABN, Citadel, Eclipse, IMC, Optiver,
Susquehanna

Transaction Cost*

Stamp Duty
Trading Fee

SFC Levy
Commission Rate

Contract Multiplier
Liquidity Providers

Stamp Duty
Trading Fee

SFC Levy
Commission Rate
ATrading fee discount at HK$2.5,

X

Data Source: HKEX

Information for reference

As at 30 June 2025

N/A

HK$3.5 / contract
HK$0.54 / contract
Negotiable

HK$50
ABN, Eclipse, IMC, Optiver, Susquehanna

N/A

HK$5 / contract”
HK$0.54 / contract
Negotiable

until further notice

Weekly HSI & HSCEI Options Volume

Volume

(No. of Contracts)

m Weekly HSI Options

25,000 - m Weekly HSCEI Options
m Weekly HSTECH Options
20,000 -
15,000 -
10,000 -
5,000 -
0_
©O© O © © © © © O O O O© O O O O o o o o o o
NPT OO OS-~T AT ORNDIP OO T OO N O
T~ T T T T AN AN N AN NN
(o ¥ Contract
1( ‘;‘(‘)’O nracts)  __Weekly HSI & HSCEI &HSTECH Options Cal
S 1 =\ eekly HS| & HSCEI & HSTECH Options Put
10,000 -
5,000 -
0 T T T T T T T T T T T T T T T T T T T
O O O O O O O O© O O© O OV O© O O O O O © o ©
NPT O O TS -~NITONOISA IO O N S
~ ™Y Y Y Y - -~ N AN AN AN ANANOM

An investment tool to manage short term event risk

* All calculations are in HKD and exclude commission fees

only



Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2025 vs 2024) _“ No. of Single Stock Derivatives

Stock Futures 9,071 (+8%) 23,631 (-4%) Single Stock Futures
Stock Options (Monthly and Weekly) 868,128 (+21%) 13,374,869 (+22%) Single Stock Options 132
Stock Futures (YoY) Stock Options (YoY) Latest and Future Developments
Avera% Daily Volume Open Interest  Average Daily Volume Open Interest
No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
10.000 - Open Interest (R-Axis) Open Interest (R-Axis) , - 14,000,000
’ / - 30,000 800,000 ¢ - 12,000,000
8,000 - ] 600.000 4 10000000 Products
6000 - . 20.000 ’ . 8.000.000 > 3 A-shares ETFs futures contracts
4.000 400,000 - - 6,000,000 > Total 97 stock futures contracts
’ - 10,000 200 000 - - 4,000,000
2,000 - ’ - 2,000,000
0 - | 0 0 T rrr rr 11 111 0
5 O A 9 N g D0 PSS
B S S S P PR S BTE F
Stock Futures (MoM) Stock Options (MoM) Stock Options
Av erage Daily Volume Open Interest Average Daily Volume Open Interest * Products .
(No. of Contracts) (No. of Contracts) (No. of Contracts) ( ) (No. of Contracts) » 3 A-shares ETFs options contracts
. e ADV (L-Axis) . 1,400,000 - ADV (L-Axis - 20,000,000 i
12,888 _ Open tereat (R-Axis) [ 90:000 1400, Open nterest (R-Axis) [ 20" > Total 132 stock options pont:acts (10 of
: 1,200,000 - i them are weekly stock options*)
14,000 - - 40,000 16,000,000
151000 | 1,000,000 - /—\/\_/\
10,000 - - 30,000 800,000 - 12000000 . Market Makers (MMs)
8,000 1 - 20,000 600,000 - - 8,000,000 > 3 types of market makers (PMM/ CQMM/
6,000 1 400,000 - QRMM)
4,000 - - 10,000 590 000 - - 4,000,000 ) ) ;
2,000 ’ o 0 » CQMM to provide 50 series continuous
0 0 — uotations
sS2a8 32 5938339588575 q
SZH02 S2B0zaSu=<:=3 A Alibaba Group, Baidu, BYD, HKEX, HSBC, JD.com,
2024 2024 | 2025 Kuaishou, Meituan, Ping An, Tencent

Data Source: HKEX
* Ol compared to previous year-end
Information for reference only

As at 30 June 2025
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Hang Seng TECH Index Futures, Options and Futures Options Performance

Hang Seng TECH Index Open Interest (as of 30 June 2025)

Tracks the largest technology companies
Index Description
listed in Hong Kong Open Interest
(No. of Contracts)
400,000 -
Hang Seng TECH Index Futures & Options & Futures Options
Contract Multiplier HK$50 per index point 350,000 -
Notional Value (1 Contract) HK$265K (As at 30 June 2025) 300.000 -
No. of Liquidity Providers N/A
250,000 -
Transaction Cost* 200.000
Stamp Duty NA 3 9 8§38 3 8/§ 8 & &8 = S
©) <
Trading Fee HK$2.50 / contract < 2 z 0 | cow = = 7 |
SFC Levy HK$0.54 / contract 2024 2025
Average Daily Volume (as of June 2025)
ADV
(No. of Contracts)
250,000 -
200,000 -
150,000 -
100,000 -
50,000 -
0 -

2024 2025

Providing investors with a tool to manage their risk exposure
to Hong Kong-listed technology companies

Data Source: HKEX
* Exclude commission fees, the Exchange is offering market-wide 50% trading fee discount of HK$2.50 per contract ( the standard trading fee is HK$5.0 per contract)
Information for reference only

As at 30 June 2025

X "

Volume and Open Interest continue to growth



MSCI China A 50 Connect Index Futures Performance

o Balanced representation from 11 sectors
Index Description )
of top 50 China A shares ADV
Index Level 2,126.68 (As at 30 June 2025) (No. of Contracts)
25,000 -

Index Volatility (30-Day Historical) | 9.8 20.000
Index Avg. Day High-Low Range 15.01 (June 2025) 15,000
CSI300 Correlation (2025) 0.971 10,000
FTSE A50 Correlation (2025) 0.975 5,000

0
MSCI China A 50 Connect Index Futures
Contract Multiplier Us$25 2024 | 2025 |
Notional Value (1 Contract) US$0.05Mn (As at 30 June 2025) Open Interest (as of 30 June 2025)
Average Quote Size US$0.27Mn (5 Contracts)

Open Interest
(No. of Contracts)

19,000 -
Transaction Cost*
Stamp Duty N/A 15,000 -
Trading Fee US$0.5 / contract
11,000 -
SFC Levy US$0.07 / contract
Margin as of 27 Jun 2025 US$3,310 7,000 —
5 9 & 8 3 8|8 § 8 & T S
2 2 »n O z a5 L = < s S
2024 | 2025 |
Sector-balanced exposure to China’s A-share market Risk management tool for diversified China portfolios

Data Source: HKEX
* All calculations are in USD and exclude commission fees, the Exchange is offering market-wide 50% trading fee discount of US$0.5 per contract (the standard trading fee is US$1.0 per contract)
Information for reference only

As at 30 June 2025

X



MSCI Asia and Emerging Market Index Futures Performance

MSCI Asia and Emerging Market Index

Index Description

MSCI Asia and Emerging Market Index Futures

Contract Multiplier
Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*
Stam p Duty

Trading Fee

SFC Levy

representation 38 DM and EM countries and

regional indices

Average US$40
Average US$59K (As at 30 June 2025)
12

NA
US$0.6-US$1.0 / contract
US$0.07 / contract

HKEX with the broadest suite of MSCI derivatives products
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference only

As at 30 June 2025

X

Open Interest (As of 30 June 2025)

Open Interest
(No. of Contracts)

160,000 -
140,000 -
120,000 -
100,000 -
80,000

60,000

Jul

Average Daily Volume (As of June 2025)

ADV
(No. of Contracts)

40,000 -
30,000 -
20,000 -
10,000 -

0 -

Volume and Open Interest continue to growth

Dec




MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2025)

HSCH Correlation (2025)

representation 2 DM countries (excl. Japan)
and 9 EM countries in Asia

662.29 (As at 30 June 2025)
13.9

5.74 (June 2025)

0.856

0.826

MSCI AxJ Futures

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

Us$100

US$66K (As at 30 June 2025)
US$0.33Mn (5 Contracts)

1.3 index points (June 2025)

Flow and 11 banks

Transaction Cost*

Stam p Duty
Trading Fee
SFC Levy

Margin as of 27 Jun 2025

N/A
US$0.5 / contract
US$0.07 / contract

US$3,160

Futures contracts have relatively lower transaction costs

Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference only

As at 30 June 2025

X

Open Interest (30 June 2025)

Open Interest
(No. of Contracts)

18,000 -
12,000 -
6,000 -
0

S D a 0 > Q c Q = = > c

S 286248882283

2024 | 2025 |

MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)

MSCIAXJ e MSCI China MSCI HK
140 - MSCISG e MSClIndia - MSCI Indonesia
------------- MSCI Korea e MSCI Malaysia MSCI Pakistan
------------- MSCI Philippines  -+++--- MSCI Taiwan M§Q.1,Th.ail_qnd

120 - [

100

80 -

60 . .
Apr-2025 May-2025 Jun-2025

MSCI AxJ is a well-established benchmark representing Asia
regional (excluding Japan) equity market performance

13



Hang Seng Mainland Banks Index Futures Performance

Hang Seng Mainland Banks Index (HSMBI) 5-Min Avg. Bid-Ask Spreads (30 June 2025)

Index Description 10 largest and most representative
: HKEX-listed mainland banks stocks HSMBI Futures
CEB Bank 6818.HK 0.38%
Index Level 4,071.41 (As at 30 June 2025)
Bank of China 3988.HK
Index Volatility (30-Day Historical) | 19.2 Minsheng Bank 1988.HK
Index Avg. Day High-Low Range 51.02 (June 2025) PSBC 1658.HK
Bankcomm 3328.HK
HSI Correlation (2025) 0.797 CITIC Bank 998.HK
HSCH Correlation (2025) 0.81 ABC 1288.HK
ICBC 1398.HK
CM Bank 3968.HK
Hang Seng Mainland Banks Index Futures CCB 939.HK
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.20Mn (As at 30 June 2025)
Avg. Quote Size HK$1.02Mn (5 Contracts) Index & Constituents 3-Month Performance (Rebased to 100)
Avg. Bid-Ask Trading Spread N/A 130 - e HSMBI ——CCB (939.HK)
ICBC (1398.HK) BOC (3988.HK)
Liquidity Providers N/A ——ABC (1288.HK)
120 + ;
, 110 "w/\
Transaction Cost* M/
Stamp Duty N/A 100 /N
"
Trading Fee HK$2 / contract 90
SFC Levy HK$0.54 / contract
80 T T )
Margin as of 27 Jun 2025 HK$9,550 Apr-2025 May-2025 Jun-2025
Futures contracts have relatively lower transaction costs HSMBI Futures can be used for hedging

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference only

As at 30 June 2025

X



CES120 Index Futures Performance

CES120 Index

5-Min Avg. Bid-Ask Spreads (30 June 2025)

80 A-Shares and 40 HK-listed Mainland

Index Description . . )
China H-shares, P-chips, and red chips

CES120 Futures | N/A
Index Level 6,492.22 (As at 30 June 2025)
Index Volatility (30-Day Historical) | 13.1

Index Avg. Day High-Low Range 53.71 (June 2025)

cnnaannc csaoo 7 s ([ -
CSOP FTSE A50 ETF (2822.HK) _ 0.18%
FTSE A50 Correlation (2025) 0.865

CES120 Index Futures X iShares A50 ETF (2823.HK) _ 0.11%

Contract Multiplier HK$50

CSI300 Correlation (2025) 0.892

Notional Value (1 Contract) HK$0.32Mn (As at 30 June 2025)

Average Quote Size HK$1.62Mn (5 Contracts) CES120 & Top Constituents’ 3-Month Performance
Rebased to 100

Average Bid-Ask Trading Spread| N/A

120 1 CES120 Index Tencent CCB
Liquidity Providers N/A Ping An —— China Mobile
110 -
Transaction Cost*
100
Stamp Duty N/A
Trading Fee HK$5 / contract 90
SFC Levy HK$0.54 / contract
: 80 T .
Margin as of 27 Jun 2025 HK$17,040 Apr-2025 May-2025 Jun-2025
Futures contracts have relatively lower transaction costs CES120 Futures can be used to hedge A-share positions

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference only

As at 30 June 2025

X



Flagship Futures - Contract Specifications

Hang Seng China Enterprises Index

Hang Seng Index Futures Hang Seng TECH Index Futures

Futures

Underlying Index
HKATS Code
Contract Multiplier
Minimum
Fluctuation

Contract Months

Pre-Market
Opening Period

Trading Hours

Last Trading Day

Final Settlement
Price

Exchange Fee

Data Source: HKEX

X

Hang Seng Index Hang Seng China Enterprises Index Hang Seng TECH Index
HSI HHI HTI

HK$50 per index point

One index point

Short-dated Futures: Spot, next three

Short-dated Futures: Spot, next three calendar month & next three calendar quarter calendar month & next three calendar
months; quarter months;
Long-dated Futures: The three months of Jun and Dec plus the next three months of Dec Long-dated Futures: The three months of
Jun and Dec

8:45 am - 9:15am & 12:30 pm - 1:00 pm

9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am
(Closed at 4:00 pm on the Last Trading Day)

The second last trading day of the contract month
Average quotations of the underlying index taken at five minute intervals during the Last Trading Day

HK$10.00 HK$3.5 HK$5.00

16



Flagship Options - Contract Specifications

. Hang Seng China Enterprises .
“ Hang Seng Index Options Index Options Hang Seng TECH Index Options

Underlying Index Hang Seng Index Hang Seng China Enterprises Index Hang Seng TECH Index
Monthly contracts: HSI Monthly contracts: HHI

HKATS Code Weekly contracts: “HSI” + Strike + Month +  Weekly contracts: “HHI” + Strike + HTI
Year + “W” + Expiry Day Month + Year + “W” + Expiry Day

Contract Multiplier HK$50 per index point

Minimum Fluctuation One index point

Monthly contracts
Short-dated Options: Spot, next three calendar months & next three calendar
quarter months;
Long-dated Options: the next 3 months of Jun & Dec
and the following 3 Dec months

Monthly contracts
Short-dated Options: Spot, next three
calendar months & next three
calendar quarter months;
Long-dated Options: the next 3 months of

Contract Months /
Contract Weeks

Weekly contracts

Spot Week and the next week, except where the Expiry Day of the Weekly Contract Jun & Dec
is the same as the Expiry Day of the Spot Month Contract
Exercise Style European Style
Option Premium Quoted in whole index points
Short-dated Options (monthly and weekly contracts): Long-dated Options (monthly contracts only):
Strike Price = 20,000 200 = 20,000 400
= 5,000 and < 20,000 100 = 5,000 and < 20,000 200
< 5,000 50 < 5,000 100
Trading Hours 9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am (Closed at 4:00 pm on the Expiry Day)
Expiry Day The second last trading day of the contract month (monthly contracts)

The last trading day of the contract week (weekly contracts)

Official Settlement
Price

Exchange Fee HK$10.00 HK$3.50 HK$5.00

Average of quotations of the Index taken at five minute intervals during the Expiry Day

Data Source: HKEX

X .



Flagship Futures Options - Contract Specifications

Hang Seng Index Futures Hang Seng China Enterprises Hang Seng TECH Index Futures
Options Index Futures Options Options

Hang Seng China Enterprises Index

Underlying Index Hang Seng Index Futures Hang Seng TECH Index Futures

Futures
HKATS Code PHS PHH PTE
Contract Multiplier HK$50 per index point
Min. Fluctuation One index point
Short-dated Options: Spot, next three
Short-dated Options: Spot, next three calendar months & next three calendar months & next three calendar
Contract Months calendar quarter months and quarter months and
Long-dated Options: the next 3 months of June & December and the Long-dated Options: the next 3 months
following 3 December months of June & December after Short-dated
Options
Exercise Style European Style
Option Premium Quoted in whole index points
Index points | Strike interval Index points Strike interval
Short-dated Options: Long-dated Options:
Strike Price > 20,000 200 > 20,000 400
25,000 and < 20,000 100 2 5,000 and < 20,000 200
< 5,000 50 < 5,000 100

9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am
(Closed at 4:00 pm on the Expiry Day)

Expiry Day The third Friday of the contract month

Trading Hours

Settlement on Physical delivery on Exercise. All in-the-money options are automatically exercised upon expiry

Exercise

Official Settlement Average of quotations of the Index Futures Contract of the same contract month,

Price taken at five second intervals from 3:55 p.m. — 4:00 p.m. on the Expiry Day of the Index Futures Options
Exchange Fee HK$10.00 HK$3.5 HK$5.0

Data Source: HKEX

X



Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTI/<yy><m>.HF HTI/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DZH HTI

East Money HTI

Information

ESunny Information ~ HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI China A 50 Connect Index Futures Access Codes

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790
ACTIV Financial MCA/<yy><m>.HF
Bloomberg L.P. MCYA Index
Colt Technology MCAmy
East Money Information MCA
ESunny Information MCA

ETNet MCA
Infocast Ltd MCA
N2N-AFE 870939
Refinitiv O#HMCA:
SIX Financial MCAmy
Wind MCAF.HK

Data Source: HKEX

X
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MSCI Asia and Emerging Market Index Futures Access Codes

MSCI
Information (USD) Index
Vendor Futures
Bloomberg HKCA Index
Refinitiv 0#HMAN:
WIND MANF.HK

MSCI EM ex
Korea NTR
Information |(USD) Index
Vendor Futures
Bloomberg HQIA Index
Refinitiv O#HMXK:
WIND

MSCI Japan
Information |NTR (JPY)
Vendor Index Futures
Bloomberg HQBA Index
Refinitiv O#HMJJ:
WIND

Information |(USD) Index

Vendor Futures
Bloomberg HOBA Index
Refinitiv 0#HMGN:
WIND

Data Source: HKEX

X

MSCI EM Asia |MSCI EM Asia
MSCI China ex Korea NTR
Connect (USD) (USD) Index (USD) Index
Index Futures Futures Futures
MCYA Index CSIA Index CJEA Index HQOA Index HQRA Index HRSA Index HQTA Index HQDA Index
0#HMCA: O#HCHI: O#HCHN: 0#HMAC: O0#HMAK: O#HEAN: O#HMEE: O#HMXC:
MCAF.HK EANF.HK

MSCI EM
LatAm NTR
(USD) Index
Futures

HQYA Index
O#HMEL:

MSCI Japan
NTR (USD)
Index Futures

HJCA Index
O0#HMJU:
MJUF.HK

MSCI

Singapore
NTR (USD)
Index Futures

HKPA Index
O0#HMSN:

HMPA Index
O0#HMEM:

MSCI Malaysia
(USD) Index
Futures

HMYA Index
O#HMMY:

MSCI Taiwan
(USD) Index
Futures

HJAA Index
O#HMTW:
MTWF.HK

HMOA Index
O#HEMN:

HLCA Index
O0#HMHN:

MSCI New
MSCI Malaysia [Zealand NTR
NTR (USD) (USD) Index
Index Futures |Futures
HKEA Index HOPA Index
O0#HMMN: O#HMNZ:
MMNF.HK

MSCI Taiwan
MSCI Taiwan |25/50 NTR
25/50 (USD) (USD) Index
Index Futures |Futures
HRCA Index HRDA Index
O#HTWP: O#HTWN:

MSCI

MSCI India Indonesia

NTR (USD)

Index Futures
HRTA Index HJDA Index HMLA Index
0#HMDA: O#HMIN: 0#HMID:

MINF.HK
MSCI Pacific MSCI
ex Japan NTR |[MSCI Pacific [Philippines
(USD) Index |NTR (USD) (USD) Index
Futures Index Futures |Futures
HRPA Index HRBA Index = HNSA Index
O#HMPJ: 0#HMPC: 0#HMPH:

MSCI Taiwan |MSCI Thailand [MSCI Thailand
NTR (USD) (USD) Index |NTR (USD)
Index Futures |Futures Index Futures
HJBA Index HMTA Index HKDA Index
O#HMWN: O#HMTH: O#HMTN:
MWNF.HK MTNF.HK

(JPY) Index

Futures
HKBA Index HQAA Index
0#HMDN: O#HMJP:
MDNF.HK

MSCI

Singapore

Free (SGD)
Index Futures [Index Futures
HLEA Index HKOA Index
0#HMPN: 0#HMSG:

MSCI Vietham [MSCI Vietnam
(USD) Index |NTR (USD)
Futures Index Futures
HNTA Index HKSA Index
O#HMVT: 0#HMVN:
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Weekly HSI and HSCEI Options Access Codes

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O0#HSIW*.HF> <0#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJmy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF

Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X
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Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor Mainland Banks Mainland Banks
Index Index Futures

AASTOCKS 221420
Activ Financial =0200700.HK MBI/16K.HF
AFE 837451 870809
Bloomberg HSMBI Index BMWA Index
DB Power MBI

ET Net MBN MBI
Infocast HSMBI MBI
QuotePower SEHK.HHSMBI P11223
Telequote MBImy
Refinitiv .HSMBI O0#HMBI:

Mainland Information Vendors

Information Vendor Mainland Mainland Banks
Banks Index Index Futures

East Money HSMBI MBI
Hexin Flush Financial MBIC
Pobo Financial MBI+Month+Year
Qianlong 999905 209
Wind HSMBI MBIF+yymm+HK

Data Source: HKEX

X
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 0#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Etr:jeng Zhou Esunny Information Technology Co, _ CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X
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